Panasonic
CONNECT

4K PTZ Camera for an era of enhanced
creativity and the pursuit of visual expression.

Key Features

Uncompromising shooting performance and operability

AW- U E 1 6 0 Optical low-pass filter significantly reduces moiré

The AW-UE160 4K PTZ camera features a newly developed 4K 1" MOS Newly developed 4K Sensor offering superior sensitivity
sensor that offers the highest sensitivity of Panasonic's entire PTZ
lineup. Production teams shooting in a concert venue or a church can

Significantly improved Autofocus with advanced technology

easily capture clear images even in the most challenging lighting SMPTE 2110 Supportwith purchase of additional software key
conditions. Meanwhile, the UE160's new optical low pass filter reduces , - S 4

o ) ) ) . Realize next-generation video production with various
the effect of moiré for clearer picture quality when shooting against shooting methods and functions.

an LED wall, which is especially important for rental and staging or
worship environments. Its high-speed frame rate will help sports
broadcasters capture slow motion shots in HD for replays, while
seamless integration with the robotic camera system brings live
broadcast-style movements to the PTZ, resulting in a dynamic and
highly engaging video production.

Ease of use and versatility reduces stress of shooting on-site.
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AW-UE160

https://latam.connect.panasonic.com
/mx/es/products/broadcast-
proav/aw-ue160

General-> Power Requirements
General -> PoE

General -> Current Consumption
General-> Ambient Operating
Temperature

General-> Ambient Operating
Humidity

General -> Storage Temperature
General -> Weight

General -> Dimensions

General -> Finish

General -> Controller Supported *1
Camera Unit-> Imaging Sensor
Camera Unit -> Effective Pixels
Camera Unit->Zoom

Camera Unit-> Lens

Camera Unit-> Conversion Lens

12VDC+10% (10.8Vto13.2V)
POE++

IEEEB02.3bt standard: DC 42 V to 57 V (Camera Input)

(Software authentication (LLDP) is supported).
5.0A (XLR IN connector), 1.5A (PoE++ power supply)
0 °Cto 40 °C(32 °Fto 104 °F)

20 % to 90 % (no condensation)
-20°Cto 50 °C(-4 °Fto 122 °F)

Approx. 4.6 kg (10.14 Ibs) (excluding mount bracket)
W213 mmxH 277 mmxD 240 mm

(8.39 inches x 10.91 inches x 9.45 inches)

(excluding protrusions, ceiling mount bracket)
AW-UE160W: Pearl white

AW-UE160K: Black

See the "Compatibility Chart for Operation Devices and Application Software" page
1-type 4K MOSx1

Approx. 9,620,000 pixels

+ Optical zoom: 20x

+i.Zoom: UHD 24x, FHD 32x

- D.Extender zoom: 1.4x, 2x
Motorized Optical 20x zoom, F2.8 to F4.5

[f=8.8 mm (11/32 inches)to 176.0 mm (6-15/16 inches),

35 mm (1-3/8 inches) equivalent: 24.5 mm (31/32 inches) to 490.0 mm (19-9/32 inches)]

Not supported

Camera Unit-> Angle of View Range Horizontal angle of view: 75.1° (wide) to 4.0° (tele)

Camera Unit -> Optical Filter -> ND
Filter

Camera Unit -> Focus

Camera Unit-> Focus Distance

Camera Unit -> Color Separation
Optical System
Camera Unit -> Standard Sensitivity

Vertical angle of view: 46.7° (wide) to 2.3° (tele)

Diagonal angle of view: 82.8° (wide) to 4.6° (tele)
Through, 1/4,1/16, 1/64 *4, (Through is used as “Night mode”)

Switching between auto and manual
Entire zooming range: 1000 mm (3.3 ft)

Wide end: 100 mm (0.33 ft)
1MOS

F14/2,000Ix (Low Light), F11 /2,000Ix (Normal) (59.94Hz)

F15/2,000Ix (Low Light), F12 / 2,000Ix (Normal) (50Hz)

Camera Unit -> Horizontal Resolution -1,600 TV lines Typ (Center area)

> 4K

Camera Unit-> Gain Selection *2
Camera Unit -> Frame Mix *3
Camera Unit-> Electronic Shutter

Speed -> 60p

Auto, -6 dBto 12 dB >
Auto, 0 dB, 6 dB, 12 dB, 18 dB, 24 dB "©
1/60,1/100, 1/120, 1/125, 17250, 1/500, 1/1000, 1/1500, 1/2000


https://latam.connect.panasonic.com/mx/es/products/broadcast-proav/aw-ue160

Camera Unit -> Electronic Shutter
Speed -> 59.94p/59.94i

Camera Unit -> Electronic Shutter
Speed -> 50p/50i

Camera Unit-> Electronic Shutter
Speed -> 29.97p

Camera Unit-> Electronic Shutter
Speed -> 25p

Camera Unit-> Electronic Shutter
Speed -> 23.98p/24p

Camera Unit -> Electronic Shutter
Speed -> 59.94p/120fps

Camera Unit -> Electronic Shutter
Speed -> 50p/100fps

Camera Unit-> Synchro Scan -> 60p

Camera Unit-> Synchro Scan ->
59.94p/59.94i

Camera Unit-> Synchro Scan ->
50p/50i

Camera Unit-> Synchro Scan ->
29.97p

Camera Unit-> Synchro Scan-> 25p

Camera Unit-> Synchro Scan ->
23.98p/24p

Camera Unit-> Synchro Scan ->
59.94p/120fps

Camera Unit-> Synchro Scan ->
50p/100fps

Camera Unit-> Gamma

Camera Unit -> White Balance

Camera Unit-> Chroma Amount
Variability

Camera Unit-> Scene File
Camera Unit-> Color Bar

1/60,1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000

1/60,1/100, 1/125, 1/250, 1/500, 1/1000, 1/1500, 1/2000
1/48,1/50,1/60,1/96,1/100,1/120, 1/125,1/250, 1/500, 1/1000, 1/1500, 1/2000
1/48,1/50, 1/60, 1/96, 1/100, 1/125,1/250, 1/500, 1/1000, 1/1500, 1/2000
1/48,1/50,1/60, 1/96, 1/100, 1/200, 1/125,1/250, 1/500, 1/1000, 1/1500, 1/2000
1/125,1/250, 1/500, 1/1000, 1/1500, 1/2000

1/125,1/250, 1/500, 1/1000, 1/1500, 1/2000

60.00 Hz to 7200 Hz
60.00 Hz to 7200 Hz

50.00 Hz to 7200 Hz
30.00 Hz to 7200 Hz

25.00 Hz to 7200 Hz
24.00 Hz to 7200 Hz

120.00 Hz to 7200 Hz
100.00 Hz to 7200 Hz

HD / NORMAL / CINEMA1 / CINEMA2 *7

MASTER GAMMA (0.15 ~0.75)

R GAMMA (-75 ~ +75)

B GAMMA (-75 ~ +75)

R BLACK GAMMA (-20 ~ +20)

B BLACK GAMMA (-20 ~ +20)
ATW "8:3200K, 5600K

AWB : AWB-A / AWB-B

VAR (selectable between 2000K and 15000K by designating a value)
OFF, -100 % to 40 %

Scenelto8

SMPTE, FULL

ARIB (FHD): Output of base band type only

ARIB (UHD): Output of base band type UHD only

ARIB (2020/HLG): Output of base band type UHD only

+IP display color bars do not conform with SMPTE

Camera Unit-> Output Format (SDI) ->2160/60p, 2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p

4K

(Native), 2160/23.98p (Native)

Camera Unit -> Output Format (SDI) ->1080/119.88p ~1© *1 1080/100p 19 17, 1080/60p, 1080/59.94p, 1080/50p,

HD

1080/29.97p (Native), 1080/25p (Native), 1080/24p (Native), 1080/23.98p (Native),
1080/59.94i, 1080/50i, 720/59.94p, 720/50p

Camera Unit -> Output Format (HDMI)2160/60p, 2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p

-> 4K

(Native), 2160/23.98p (Native)

Camera Unit-> Output Format (HDMI)1080/119.88p, 1080/100p, 1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native),

->HD

Camera Unit -> Output Format(Fiber

(video only)) -> 4K

Camera Unit -> Output Format(Fiber

(video only)) -> HD

Camera Unit -> Output Format(ST
2110) ™12

Synchronization System

Input Connector -> DCIN

Input Connector -> G/L IN

1080/25p (Native), 1080/24p (Native), 1080/23.98p (Native), 1080/59.94i, 1080/50i,
720/59.94p, 720/50p

2160/59.94p, 2160/50p, 2160/29.97p (Native), 2160/25p (Native), 2160/24p (Native),
2160/23.98p (Native)

1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native), 1080/25p (Native), 1080/24p
(Native), 1080/23.98p (Native), 1080/59.94i, 1080/50i, 720/59.94p, 720/50p

1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p (Native), 1080/25p (Native), 1080/24p
(Native), 1080/23.98p (Native), 720/59.94p, 720/50p

Internal/External synchronization (BBS/Tri-level sync)

DC12VIN

BBS (Black Burst Sync), tri-level sync supported



Input Connector -> AUDIO INPUT ->
XLR

Output Connector -> HDMI

Output Connector -> 12G-SDI OUT
Output Connector -> 3G-SDI OUT1

Output Connector -> 3G-SDI OUT2/PM SMPTE424M/SMPTE292M/ 75 Q (BNC x 1)

Output Connector -> SFP+

Output Connector -> USB
Input/Output Connector -> LAN
Input/Output Connector -> RS-422
Input/Or}gut Connector -> SFP+ (ST
2110)

XLR (2ch) or MIC/LINE Input compatibles (SDI/HDMI/IP)
AAC compatibility (compatible with IP only)
XLR 3-pin female balanced input: 2ch
* During MIC input
Input level: -50 dBu or -60 dBu/-40 dBu (0 dB=1 V/Pa, 1 kHz)
Phantom power compatible, Supply voltage: 47 V+2 V
Input impedance: Approx. 10kQ
* During LINE input
Input level: 0 dBu (or +4 dBu/-20 dBu)
Input impedance: Approx. 10kQ
+ Input volume variable range: -40 dB to 0 dB to +20 dB (1 dB step)
» Embedded audio output level: -12 dBFS/-18 dBFS/-20 dBFS
+ Sampling frequency: 48 kHz

* Quantization bit rate: 24 bit (SDI/HDMI), 16bit (IP)
HDMI 2.0 standard

4:2:2/10bit 13714

SMPTE2082_1, SMPTE424M/SMPTE292M/ 75 Q (BNC x 1)*1 5

SMPTE424M/SMPTE292M/ 75 Q (BNC x 1) 12
15

SFP+ compliant (Single Fiber) *1 6, MSA standard compliant product
USB3.0 HOST 5G mobile router (with USB tethering support 17
LAN connector for IP control (RJ-45) 100BASE-TX/1000BASE-T
CONTROL IN RS-422A (R}-45)

Compatible protocol:

+ST2120-10/-20/-21/-22/-30

* PTP ST 2059-1/2

* NMOS IS-04/1S-05

Number of outputs:

[Uncompressed] Video x3 (Main line, Crop, Monitor), Audio x2
[JPEG XS] Video x1 (Main line, Crop), Audio x2

Number of inputs: Video x1 (RETURN)

18

Video format: FHD, UHD *

Please refer to the operating instruction manual.



Pan-tilt Head Unit -> IP connecting » With PoE++ ethernet hub

cable

LAN cable *! 9(category Se or above, straight cable) up to 100 m

+ Without PoE++ ethernet hub

*19 . *20

LAN cable (category 5e or above, straight cable) up to 100 m
Pan-tilt Head Unit -> AW protocol LAN cable * 9(category 5e or above, straight cable) up to 1000 m
connecting cable

*
Pan-tilt Head Unit -> Installation Stand-alone (Desktop) or suspended (Hanging) 21
Method
*

Pan-tilt Head Unit -> Pan/tilt Operation0.08 °/s to 180°/s (Normal mode) 22
Speed

Maximum speed:

Normal mode: 60°/s, Fast1 mode: 90°/s, Fast2 mode: 180°/s
Pan-tilt Head Unit -> Panning Range  +175°
Pan-tilt Head Unit -> Tilting range -30°to 210° *
Pan-tilt Head Unit -> Quietness NC35 orless *
Supported Operating SysteT1s1and Windows®10
Web Browsers -> Windows

22
23

Microsoft Edge

Google Chrome
Supported Operating S¥stems and macOS 10.13 / Safari 13
Web Browsers -> Mac !

macOS 10.14 / Safari 13
macOS 10.15 / Safari 13

mac0S 10.15 / Google Chrome
Supported Operating Systems and ioS
Web Browsers -> iPhone/iPad

Safari

iPadOS
Supported Operating Systems and Android OS
Web Browsers -> Android

Google Chrome
IP Streaming -> Image Streaming JPEG (MJPEG), H.264, H.265, NDI® High Bandwidth, NDI® H
Mode
IP Streaming -> Image Resolution 3840x2160, 1920x1080, 1280x720, 640x360
IP Streaming -> Image Transmission Frame Rate: Maximum 30 fps 2627
Setting (JPEG)

X 24 *25

Image quality (Fine / Normal)
IP Streaming -> Image Transmission Unicast port (AUTO)
Setting (H.264) -> Transmission Type

Unicast port (MANUAL)

Multicast port
IP Streaming -> Image Transmission CBR, VBR
Setting (H.264) -> Transmission mode
IP Streaming -> Image Transmission [60Hz] 5fps/ 15fps /30fps / 60fps (UHD: 30fps, 60fps)
Setting (H.264) -> Frame Rate

[50Hz] 5fps / 12.5fps / 25fps / 50fps (UHD: 25fps, 50fps)
IP Streaming -> Image Transmission 2048kbps/4096kbps /8192kbps /10240kbps /12288kbps / 14336kbps / 20480kbps /
Setting (H.264) -> Max Bit Rate 24576kbps / 51200kbps / 76800kbps
IP Streaming -> Image Transmission Unicast port (AUTO)
Setting (H.265) -> Transmission Type

Unicast port (MANUAL)

Multicast port
IP Streaming -> Image Transmission CBR, VBR
Setting (H.265) -> Transmission mode
IP Streaming -> Image Transmission [60Hz] 30fps /60fps
Setting (H.265) -> Frame Rate

[50Hz] 25fps / 50fps



IP Streaming -> Image Transmission
Setting (H.265) -> Max Bit Rate

IP Streaming -> Audio Compression
Format

2048kbps / 4096kbps / 8192Kbps / 10240Kkbps / 12288Kkbps / 14336kbps / 20480kbps /
24576kbps /51200kbps / 76800kbps
AAC-LC, 48 kHz / 16 bit / 2ch

IP Streaming -> Supported Protocol -> ICMP, ARP, GARP, MLD

Network Protocol

IP Streaming -> Supported Protocol -> TCP/IP, UDP/IP

Transmission Protocol

IP Streaming -> Supported Protocol -> IPv4: HTTP, HTTPS, DNS, NTP, DHCPv6, MDNS, SNMP, 802.1X

IPV6

IP Streaming -> Supported Protocol -> IPv6: HTTP, HTTPS, DNS, NTP, DHCPv4, MDNS, SNMP, 802.1X

IPv4

IP Streaming -> Supported Protocol -> RTP / RTCP over RTSP, RTMP, RTMPS, SRT, MPEG2-TS over UDP, NDI® high bandwidth,

Video Streaming Protocol

NDI® HX

IP Streaming -> Supported Protocol -> FreeD, TSL5.0, SNMP

External Device Cooperation Protocol

NDI® Support-> NDI® Support

N DI® Support-> Output Format
(NDI® High bandwidth) -> 4K

N DI® Support-> Output Format
(NDI® High bandwidth) -> HD
nDI® Support-> Image Resolution
(NDI® HX)

NDI® Support-> Image Streaming
setting (NDI® High bandwidth) ->
Transmission Type

nDI® Support->Image Streaming
setting (NDI® High bandwidth) ->
Max Bit Rate

NDI® Support-> Image Streaming
Setting (N DI® HX) -> Transmission
Type

NDI® Support -> Image Streaming
Setting (N DI® HX) -> Flame rate

npI® Support-> Image Streaming
setting (NDI® HX) -> Max Bit Rate

npI® Support-> Audio Compression
Type (N p1® High bandwidth)

nDI® Support-> Audio Compression
Type (NDI® HX)

Other Function -> VR Support
(IP/RS422)

ST 2110 -> Supported Format

ST 2110 -> Number of Outputs (TX) ->

Video

ST 2110 -> Number of Outputs (TX) ->

Audio

ST 2110 -> Number of Outputs (TX) ->

Auxiliary data

ST 2110 -> Number of Inputs (RX) ->
Video

ST 2110 -> Number of Inputs (RX) ->
Audio

ST 2110 -> Number of Inputs (RX) ->
Auxiliary data

ST 2110 -> Output Format -> Video
format

ST 2110 -> Output Format -> Audio
specifications (MIC1/2)
ST 2110 -> Input Format

Optional Accessories -> Wireless
Remote Controller
Footnote Description

; ) *24 %25
NDI®(High Bandwidth NDI®, NDI® |HX Ver.2)

2160/59.94p, 2160/50p, 2160/29.97p, 2160/25p, 2160/24p, 2160/23.98p
1080/60p, 1080/59.94p, 1080/50p, 1080/29.97p, 1080/25p, 1080/24p, 1080/23.98p,
720/59.94p, 720/50p

1920x1080, 1280x720 22

Transmission Type: TCP/UDP

Unicast/Multicast
Max 250 Mbps

TCP/UDP

Unicast/Multicast
[60Hz] 5fps / 15fps / 30fps / 60fps

[50Hz] 5fps / 12.5fps / 25fps / 50fps

512kbps / 768kbps / 1024kbps / 1536kbps / 2048kbps / 3072kbps /4096kbps /
6144kbps / 8192kbps / 10240kbps / 12288kbps / 14336kbps / 16384kbps / 20480kbps /
24576kbps

AAC, 48 kHz, 2 ch

AAC-LC, 48 kHz,16 bit, 2 ch

Supported

ST2110:10/20/21/30

PTP: ST2059-2

NMOS: IS-04/1S-05

3 channels (Full x 1, MONI x 1, Crop x 1)
2 channels

No output

1 channel (RETURN) “30

No input

No input

Full x1, MONI x1, Crop x1, all the same format

1080/60p, 1080/59.94p, 1080/50p, 1080/59.94i, 1080/50i, 1080/29.97p (Native),
1080/25p (Native), 1080/24p, 1080/23.98p (Native), 720/59.94p, 720/50p
PCM/ 48kHz / 24bit / 1ch x2

1080/60p, 1080/59.94p, 1080/50p, 1080/59.94i, 1080/50i, 1080/29.97p (Native),
1080/25p (Native),1080/24p, 1080/23.98p (Native), 720/59.94p, 720/50p
AW-RM50AG (Size "AA" dry battery x2, obtained separately)

*NDI® is aregistered trademark of Vizrt NDI AB in the United States and other countries.

1. Limited in function when PoE used.



.IP only.

. Connection with digest authentication is not

guaranteed to work in a case where you are using a
Panasonic Controller (AW-RP150, AW-RP60 ).
Smooth operation may be diminished when
connection with digest authentication. Use host
authentication or the HTTPS function.

.Equipped with Low pass filter.
.Can be set in 1dB step increments.

.Ifformat is set in 2160/29.97p, 2160/23.98p,

2160/24p, 2160/25p, 1080/29.97p,1080/25p, it
cannot be set.

.HLG is set in other menu.

8. ATW Speed 3-stage variables

9.The color bar on the IP display is not compliant with

10.

11.

12.

13.

SMPTE.

1080/119.88p and 1080/100p use two 3G SDI
OUT1/2 channels.

No output from 12G/SDL

Requires activation with the separately sold
Operational Software Key AW-SFUG60.

HDCP is not supported.

14.Viera Link is not supported.

15.

16.

17.

18.

19.

20.

21.

22.

23.

Compatible with Level-A/Level-B.

Optical signal input not supported.

Limited power supply to USB_Wifi dongle.

Follows the system format.

STP (Shielded Twisted Pair) is recommended.

Use Category 6 or higher for 4K video transmission.

For safety reasons, it must be secured with the
included mounting hardware.

Depending on the PAN/TILT position, the main unit
may be reflected in the video image.

NC25 or less when P/T is stationary.



24.NDI® is a new live video production workflow
support protocol for IP use developed by NewTek,
Inc.

25.NDI® is a registered trademark of NewTek, Inc. in
the United States and other countries.

26. No bit rate specified.

27.)JPEG and H.264, JPEG and H.265 simultaneous
operation depends on bit rate.

28. NDI® has no image resolution specifications.
29.NDI® | HX has no output format specifications.

30. Output from 3G SDI OUT2 (Video is changed in the
OSD menu)






